Chapter 3 Microsoft Excel 2010

Welcome to the world of Excel. Now in the business world, the financial world, the
manufacturing world, and any other industry you can think of, you will see people using Excel. It
is by far one of the most used programs in the history of business applications.

The contents of this chapter are sketched in Figure 3-1.

Microsoft Excel 2010

Overview Experiment I: Experiment 2: Experiment 3:
Basic Excel Advanced Excel Excel Project
Elements Cremes Lnsert Formulas | | Design || Charts Filter Sort Subtotal
table Delete

Figure 3-1 The relationship chart of this chapter

3.1 An Overview of Microsoft Excel 2010

To make managing and analyzing a group of related data easier, you can turn a range of cells

into an Excel table as shown in Figure 3-2.

A A B | C D |
1__ Product [~ | arr1 H Qtr2 B Grand Totzﬂ
2 |Chocolade $74460 $162.56 $907.16
3 |Gummibarchen $5.079.60 $1.249.20 $6.328.80
4 |Scottish Longbreads $1267.50 $1,062.50 $2.330.00
5_ Sir Rodney’s Scones $1.418.00 $756.00 $2.174.00
6 |Tarte au sucre §4.728.00 $454792 §9.275.92
7 |Chocolate Biscuits §943.89 $349.60 $1,293.49
8 |[Total §14,181.59 $8,127.78 $22,309.37

Figure 3-2  An example of an Excel table



i AU wh 5 FRAEF (R )

3.1.1 The elements of Excel table

A table can include the following elements

1. Header row

By default, a table has a header row. Every table column has filtering enabled in the header
row so that you can filter or sort your table data quickly, which are shown in Figure 3-3. And you
can turn off the header row in a table.

2. Banded rows

Alternate shading or banding in rows helps to better distinguish the data, as shown in

Figure 3-4.

y A B C
I Product ﬂ Qur1Eatr 2 B
(2] SortAtoZ $16.00
2l sonzion  RRARRORERERRN 1124920
Sort by Color 1,062.50
2 $756.00
: 4,547.92
Filter by Color ’
$349.60
Text Filters 4
Search /O
W (Select All)
¥Chocolade
Chocolate Biscuits Al A 8 | C
ummibﬁrchen = I Columni B Coumn2Bl Column3 Bl
¥|Scottish Longbreads 2 |Product Qtr 1 Q2
¥Sir Rodney's scones 3 |Chocolade 7446 162.56
v|Tarte au sucre 4 |Gummibarchen 5079.6 12492
5 !Sccrtish Longbreads 1267.5 1062.5
Figure 3-3  Filter data and Sort data Figure 3-4 Banded rows

3. Calculated columns

By entering a formula in one cell in a table column, you can create a calculated column in
which that formula is instantly applied to all other cells in that table column, which is shown in
Figure 3-5.

4. Total row

Once you add a total row to a table, Excel gives you an AutoSum drop-down list to select
from functions such as SUM, AVERAGE, and so on. When you select one of these options, the
table will automatically convert them to a SUBTOTAL function, which will ignore rows that have
been hidden with a filter by default. If you want to include hidden rows in your calculations, you

can change the SUBTOTAL function arguments, which is shown in Figure 3-6.



£ || =SUBTOTAL(109,[Midwest])
SUBTOTAL function for SUM
| C : E
Revenue Audit (Small Busine:
g Europe g Midwest g Northeast =
100 $7,200 $5,700 $6,90C
100 $2,300 $9,400 $7,30C
00 59_,300 $3_,700 _58,60(_
J00  $4,300 $5,600 $5,60(
500 $23,100]  $24,400) $28,40C
None
i Average
B c | b e Count
ar1 H Qtr2 B Grand Totgd C::nt Numbers
$744.60 $162.56 } =sum(T2blel[@[Qtr 11Qt 27} | Max
$5.079.60 $1.249.20 SUM({number1, [number2], ] | Min
S
$1.418.00 $756.00 =
$472800  $454792 3:'3'“'
$94389 $349.60 More F 4
$14.18159 $8.127.78 $0.00_ _ b Ll
Figure 3-5 An example of calculated columns Figure 3-6  An example of total row
5. Sizing handle 51600 5277200
A sizing handle in the lower-right corner of $4,547.92 9,275.92
the table allows you to drag the table to the size $349.60 $129349
that you want, as shown in Figure 3-7.
3.1.2 Create a table Figure 3-7 Resize the table by sizing handle

You can create as many tables as you want in a spreadsheet. To quickly create a table in

Excel, do the following:
(1) Select the cell or the range in the data.
(2) Select “Home” —*“Format as Table” , as shown in Figure 3-8.
(3) Pick a table style, as shown in Figure 3-9.
(4) In the “Format as Table” dialog box, set your cell range.
(5) In the “Format as Table” dialog box, select the checkbox next to “My table as

headers” , an shown in Figure 3-10. if you want the first row of the range to be the header row,

and then click “OK”.

Chapter 3 Microsoft Excel 2010
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i & O Calses BT B e Awapte Genera . | & ' 'Hmrul Bad Good &= B [
. [ - A- 5 EllegeaCmr - § - % ¢ 3 3 Condions ;,‘.::.. Meutsal Cotcation | [ERTTER] . e Oeite o
Chptaard R fomt 5 Egret ot : thytes cole

AL S roduct

y A B C D E F G

1 |Product [ Qtr1 Qtr2 Grand Total

2 Long Rolls $304.03 $502.01 $806.04

3 Biscuits $2,080.83 $1,099.20 $3,180.03

4 Scones $4,504.42  $6,003.20 $10,507.62

5 Muffins $1,089.01 $1,200.80 $2,289.81

6 Crossoints $203.56 $607.82 $811.38

7 Cookies $1,103.33 $804.60 $1,907.93

8

= Select Home — Format as Table

Figure 3-8 Select “Home” —*“Format as Table”

T *.E;’; Ca 1" KK W % fweplm e L _;) | Normal Bad Good il ol

L e A ¥ FlvegenCenter - §-% v M I m::‘ Neutral Caleuistion | [CSTIEC] . 'en Oveeio
Chpoow 1 Yot pros—— Mamlar

Al S | Product

y A B C

1 = ran-

2 T el

3 Biscuits <

4 Scones $4,504.42 $6,003.20

5 Muffins $1,089.01 $1,200.80

6 Crossoints $203.56 $607.82

7 Cookies $1,103.33 $804.60

8

9

10

11

y | A B | C D E F

1 |Product rand Totall mevep—— =T

2 {Long Roll Set your cell range R ale
3 'Blscuns 3,180.03 : 2 ___. |
4 |Scones $4,50442  $6,003.20  $10,507.62 | =
5 iMuffins $1,089.01 $1,200.80 $2,289.81 | : Y '

6 |Crossoints $203.56 $607.82 $811.38 |

7 Cookies $1,10333  $80460  $1907.93

Figure 3-10  Set cell range



3.2 Experiment 1. Basic Excel

3.2.1 Experiment purpose

The purpose of this experiment is to master the operations of building and closing an Excel,

some basic operations including inserting and deleting rows and columns, basic formulas, table

design and charts.

3.2.2 Experiment contents

Experiment 3. 1

This part of experiment should be finished in “Excel Data. xlsx” and save it as “Excel Data-

practice 07

Insert a new row before the 16th row and input “Tom”, “6000”, “Master”,
“132204198810018822” , “85.5”.

Delete the 18th row ( After inserting).

Insert a new column named “Index” on the leftmost table and finish indexing.

Insert a new column named “Location” on the rightmost table and finish the input shown
in Figure 3-11.

Insert a new column named “Total Salary” on the rightmost table. The “Total Salary”
equals to “Salary * Score / 100”.

Insert a new column named “Tax Rate” on the rightmost table. When the “Total Salary”
is greater than 7000, the “Tax Rate” is 0.3. Otherwise it is O.

Insert a new column named “Age” before “Salary” and finish calculations. (Format: int
(year(today( ) )-mid(ID Card,7,4)). (Hint: you cannot input “ID Card” directly. )
Insert a heading :

(D Insert a new row before the first row and input “Information and Salary of the Dahua
Company” , Merge and Center Al:K1, and set the font to “Calibri” , size 14, bold, light
green.

@ Select A2.K2, and set the font to bold, Orange Accent 6.

Add “All Borders” on the table, and center texts.

Insert a Chart of 2D Clustered Column according to A3;C22.

After finishing this part of experiment, the final effect is shown as Figure 3-11 and
Figure 3-12.

3.2.3 Experiment procedures

3.2.3.1 Insert and Delete Rows and Columns

(1) Open the file “Excel Data. xIsx”, and save it as “Excel Data - practice 0”.
(2) Select the 16th row, right click it and select “Insert” ( Shown in Figure 3-13).

Chapter 3 Microsoft Excel 2010
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al x| 8 | ¢ D= F G | H j==l=c)
Index | Mame Salary | Diploma 1D card Score | Location | Total Tax Rate
1 Stul 31 B0D0 Master 200921198712260546 | 95.3 | Beijing 7624 03
2 Stu2 9 5000 110501197905031267 | B8.2 | Beijing 5282 ]
3 | sws| 5000 | College | 456723197901211672 | 924 | Beijing | 4620 0
4 Stu 4 0 3500 Senior High | 551164196811292168 | 75 Beijing 2625 [
5 Stus 28 6000 Bachelor [ 123642199012193315 | 85 Beijing 5100 [
] Stub 42 5000 College 543784197605081524 | BAG | Beijing 4230 ]
7 Stu7 a2 8000 Master 10540 | 656 | Beijing | 5248 0
B | sws | 51 000 | Bachelor | 123784196706304567 | 63 | Beijing | 3780 0
9 | sw9 | 50 5000 | College [ 154978196810289234 | 781 | Beijing | 3905 0
10 Stu 10 59 3500 Senior High | 456789195905084945 | B85 Beijing 3010 [
11 Stu 11 38 8000 Master 456713198007145522 | 925 | Beijing T400 03
12 Stu 12 39 6000 75 i 4500 ]
3 [ swis | s 5000 | College | 157164196703175756 | 514 2570 0
16| swis | 58 3500 | Senior High | 159456196008060917 | 332 [Shanghai| 1162 0
15 Tom 30 5000 Master 132204198810018822 | 855 i 5130 0
16 Stu 15 30 6000 132204198810018822 | &3 5280 ]
17 Stu 17 51 B0DD Master 1 164567 | BOS 6440 ]
B | swis| 3 6000 187341198211304655 | 91 st 5460 0
19 St 19 a2 5000 College 356715197607153497 | 38 [Shanghai 1900 o
20 Stu 20 3B 3500 Senior High [ 187167198007168713 | 60 |Shanghai 2100 o
Figure 3-11  The resulting table for Experiment 1
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Figure 3-12  The resulting chart for Experiment 1
Al6 _ EI
4 A | D el fF | @ L] b
1 Name Salary Diploma 1D card Score B
————— =
2 Stul 8000 » o B 95.3
3 Stu2 6000 8.2
b= Ua copy
4 stus 5000 " 924
5 |stua asop| I Peste Options: s
6 Stus 6000 [ﬁ [!] 85
7 Stub 5000 FPaste Special... B84.6
8 stu7 8000 | jncen 65.6
9 Stug 6000 Delete 63
20 .S‘IUS Clear Coptents 781
11 Stul0 3500 86
12 stuil 8000 | ' Format Cells... 925 2
13 Stul2 6000 Bow Height... 75
| 14 stu13 5000|  Hide 514
15 Stu 14 3500 Unhide
17 Stulb 5000 | calibri = 11~ A A7
18 stu 17 8000y ;= G- A-
19 Stuls 6000
ey | r
20 Stul9 5000 College 356715197607153497 38
21 Stu 20 3500 Senior High "187167198007168713 60

Figure 3-13  Right click and select “Insert”



(3) Input

Figure 3-14).

“Tom”, “6000” and “Master” from A16 to C16 respectively ( Shown in

| A6 ~E X | Tom i
4 A | B | c | D Ll e F | & {7 B (e
4 [stu3 5000 College  456723197901211672 924
5 |Stud 3500 Senior High 551164196811292168 75

| 6 stus 6000 Bachelor  '123642199012193315 85 E

| 7 stus 5000 College  '543784197605081524 84.6

| 8 stu7 8000 Master  516195197606110549  65.6

5 [stus 6000 Bachelor 123784196706304567 63

| 10 stus 5000 College  |154978196810289234  78.1

| 11 stu10 3500 Senior High '456789195905084545 86

| 12 stu11 8000 Master  456713198007145522  92.5

| 13 stu12 6000 Bachelor  '154795197905031679 75

| 14 stu13 5000 College ::snsussmans?ss 514
15 stu 14 3500 Senior High 159456196008060917 33.2

| 16 | Tom l

17 stu1s 6000 Bachelor '132204198810018822 8 =

| 18 Stu16 5000 College :::349?193511151239 7

[ 19 stu17 8000 Master 123456196702164567  80.5

| 20 stu18 6000 Bachelor  '187341198211304655 91

| 21 stu19 5000 College :mmmmmm:* a8

| 22 s5tu20 3500 Senior High '187167198007168713 60

23

24
25
%

27
28 -

Data4 72 InEh m [ 1

=TT I

Figure 3-14 Input the first 3 columns

(4) Right click D16 and select “Format Cells” (Shown in Figure 3-15).

Il s Practice on Excel Dataxdsx - Microsoft Excel - o 4
[ Home | Insert  Pagelayout  Formulas  Data  Review  View  Addins  Team & [? BER I
& Calibr - 105 - -E}- = Geneal - A a=inset- X - %r Iﬂ
Q- BIU- AW EFFEH 4 o a-
ut
Paste i Sort & Find &
- & | H- [ S-A- e - 42 Copy 27 Filter~ Select -
Clipboard & Font 7| Alignment | a Paste Options: Editing
D16 - (= £ | B ¥
) YV S [ 1 E— =
4 stu3 S000 College 467231979017
| 5 stua 3500 Senior High 5511641968113
| 6 stus 6000 Bachelor ‘1236421990121 29t~ L
| 7 stue 5000 College  '543784197605¢  Clear Contents
| 8 stu7 8000 Master 161951976061 Fittgr »
| 9 stus 6000 Bachelor 123784196706 son N
| 10 stus 5000 College 1549781968107 | vt ot
11 stu10 3500 Senior High ‘456789 =
|11 i "
12 stull 2000 Master 45671319800 =
=y | r
13 stu12 6000 Bachelor  '154795197905C
|13 i { >
14 stu13 5000 College 1571641967031 Define Name...
141 it |
15 Stu14 3500 Senior High 1594561960080 @, Hyperiink..
i o0 wster = |
| 17 5tu 15 6000 Bachelor  132204198810C Calibri - 10.5 = A™ o" 5 - % Exh =
| 18 stu1s 5000 College 1234971985112 p , EH-A- Y
|19 stu17 8000 Master "1234561967021weowr——oua- — '
| 20 |stu1s 6000 Bachelor  '187341198211304655 91
| 21 stu19 5000 College  '356715197607153497 38
| 22 stuz0 3500 Senior High '187167198007168713 60
|23
E
12
26
27
28 i ~
[ Z el 3 0

Figure 3-15 Right click D16 and select “Format Cells”

Chapter 3 Microsoft Excel 2010
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(5) Choose the tab “Number” and select the “Text” on the Category (Shown in Figure 3-16).

Format Cells ? X
[Mumber | Fil  Protection
Category:
General ~ | Sample
Number
Currency
Accounting Text format celis are treated as text even when a number is in the cell.
_i_l:: The cellis displayed exactly as entered.
Percentage
Fraction
Custom
v

[ ok | cacl |

Figure 3-16 Change the format to “Text”

(6) Input “132204198810018822” and “85.5” on D18 and E18 respectively.
(7) Select the 18" row and right click it, choose “Delete” (Shown in Figure 3-17). After
deleting, the resulting table is shown in Figure 3-18.

X H9-~-|= Practice on Excel Dataxisx - Microsoft Excel = o X
| Home | Inset  Pagelayout Formulas Data Review View  Adddns  Team & 0 o @ B2

“n - -@! =F  |General - gnset- E -
s Tme T oy gy

I U-|AN EEES |-y 3% Delete -

=i Styles | Sort & Find &
Hh-A- iEE| 9 8 B | EFomats | 2~ Fiterr select-
Font |  Alignment | Number Cells | Editing
-~ (= £ | stuls 2|
B e D [ S [ S m——

5000 College '543784197605081524 B4.6
8000 Master '5161_9513760611%49 65.6

6000 Bachelor ' 123784196706304567 63
5000 College  '154978196810289234  78.1
3500 Senior High '456789195905084345 86 i
8000 Master  456713198007145522 925
6000 Bachelor  '154795197905031679 75
5000 College  '157164196703175756 514
3500 Seniorf catibri ~ 11 - A" »" & 5, o 5|
6000 Master o
6000 nameluu'::uxm'&m';;ﬂ;y—
TS0 college
|19 [stu17 8000 Master| o 4567  80.5
| 20 stu 18 6000 Bacheld = 4655 91
| 21 stu1s 5000 College B PasteOptions: o0, 4 =
| 22 stu20 3500 senior | |5 |5 B713 60
| 23 | Paste Special...
2] Insert
25|
26
&1 =
P &' Format Cells...
| 29| Row Height...
30 Hide
|31 Unhide | | :
4 4> | patal Data2 , Dats I DaET YIT [Tel__ ] i 71 1 |
rage: 25365 Count:s sum 0. | S 100%

Figure 3-17  Delete the 18" row



Id9-™-= Practice on Excel Dataxdsx - Microsoft Excel - o ®
| Home | Insert Page Layout Formulas Data Review View Adddns  Team & e = B

& Calibri -n - -r!-I S Geneal - S=lnset~ E -
B = a3 g
h'm 7

By AL EEBE | B | o

Ee oA (2w (w7 Bleomts | @- fan o
board T Font [ Alignment | MNumber & Cells Editing
A18 & fu | Stu17 Q
AR ——c o ] e il i) i
| 7 stue 5000 College  543784197605081524 846
| 8 |stu7 8000 Master  '516195197606110589 656
| 9 lstus 6000 123 6
|10 stus 5000 College  154978196810289234  78.1
| 11/stu 10 3500 Senlor High '456789195905084945 86 E
12 stun1 8000 Master  '456713198007145522 925
|13 stu12 6000 Bachelor 15479519 ] 7
| 14 stu13 5000 College  '157164196703175756 514
_l_.s_smu 3500 Seﬂiﬂfﬂlﬂ‘l :mmmu 33.2
£Tom 6000 Master 132204158810018822 85.5
17 Stu 15 6000 Bachelor 'BW B8
| 19 stu1a 6000 Bachelor !mmmwmsss a1
| 20 stu 19 5000 College 356715157607153457 38
| 21 stu20 3500 Senior High '187167198007168713 &0 =
|22
|23
24
25
26
|27,
|28
E2)
|30
|31 -
W a0

¥l Datal Deta2 .

Figure 3-18 The resulting table after deleting

(8) Right click the first column and select “Insert” ( Shown in Figure 3-19).

|- ™-= Practice on Excel Dataxdsx - Microsoft Excel - o ®
{ r;me | Insert Page Layout Formulas Data Review View Adddns  Team & e o B
& Calibri - - -r!-I- SF  Geneal - A S=inset~ E - %r ﬁ
i-

B BJIU- A EEFE F-% s 3 Delete -

Unhide .
3500 Senior High "159456196008060917 332
6000 Master "122204198810018822 85.5
5000 32204 2 B8
B000 Master "123456196702164567 80.5

6000 Bachelor  '157341195211304655 91
5000 College  '356715197607153497 38
3500 S!niufﬂid‘l 'mnsnsammssm B0

Pty | me A (weiee (B8 || Beomne | @- fas D00k

Clipboard Calibri = (11« A" »" B - o, » BH| | Mumber & Cefly Editing
BIEN-A-D-98F i

0] I I | [ | T T

1 [Nam & cu ma  IDcard Soice =

2 (S8 2 corr "200921196712260546 953

3 |Stud @ Paste Options: lor  110501197905031267  86.2

4 BE :mmxsmmzls?z 924

sy S S High '551164196811292168 75

6 lor  123642199012193315 8

7 'sa3784197605081524 846

8 Delete '516195197606110549  65.6

9| Clear Contents lor :mmmmms? 5

m & Fomat Celts... 154978196810289234 7.1

11 Column Width... High 156785155305084545 86

12 " lse713198007145522 925 -

13 lor  '154795197905031679 7S

1“:

15

16

17

18

19

m.

g

Figure 3-19 Insert a new column
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(9) Input “Index” on Al, and “1” and “2” on A2 and A3 respectively. Select A3, press
your mouse on the lower right corner of A3 and drag to A21 (Shown in Figure 3-20).

|z|| ﬂ ). -5 Practice on Excel Dataxlsx - Microsoft Excel — m] 4
Home | Insert  Page layout Formulas Data Review View Add-Ins Team & e o g 2B

Uﬁj & Calibri - - ':l;!- SF  General - A geInset - K - %r [ﬁ
) fa- BIZ U-|A N EE=EE W% » 3% Delete - | [§- #
Paste . R Styles | Sort & Find &
. F | BH DA - <8 %8 - | [EiFormat~ | @~ Filter~ Select~
Clipboard & Font [ t I Number G Cells | Editing
A2 ~ (= v
A a | B | ¢ D | E | F [ 6 | w —
1 |Index Name  Salary Diploma ID card Score 7]
|2 ] 1istu1 8000 Master "200921198712260546  95.3
3 | 2|stu2 6000 Bachelor  '110501197905031267  88.2
4 u3 5000 College  456723197901211672  92.4
[ ua 3500 Senior High '551164196811292168 75
= us 6000 Bachelor  123642199012193315 85
|52 u6 5000 College  543784197605081524  84.6
|8 7 8000 Master '516195197606110549  65.6
|9 | l us 6000 Bachelor  '123784196706304567 63
10 u9 5000 College  154978196810289234  78.1
1n u10 3500 Senior High '456789195905084945 86
12 ull 8000 Master '456713198007145522 925 -
13 u12 6000 Bachelor  154795197905031679 75
14 u13 5000 College  '157164196703175756 514
15 ul4 3500 Senior High "159456196008060917 33.2
16 m 6000 Master ~ 132204198810018822  85.5
117 15 6000 Bachelor  '132204198810018822 88
18 u17 8000 Master "123456196702164567  80.5
19 u18 6000 Bachelor  '187341198211304655 51
20 u19 5000 College  '356715197607153497 38
21 u20 3500 Senior High 187167198007168713 60
2
23
24 T
25 -
|4 4% ¥ Datal /Data2  Data3 , Datad . %3 Ml i I [
Drag inside selection to delete cells | Average: 1.5 Count2 sum:3 |[E@E 1o (o U+

Figure 3-20 Create index for the table

(10) Input “Location” and “Beijing” on relevant positions ( Shown in Figure 3-21). Select
G2. Press your mouse on the lower right corner of G2 and drag to G12.

(11) Input “Shanghai” from G13 to G21 in the same way (Shown in Figure 3-22).

3.2.3.2 Basic Formulas

(1) Input “Total Salary” on HI. Select H2. Input the formula “ =C2 * F2/100 ”. Or
input ‘=", and then click C2, and input ‘ * ’, and click F2, and finally input “ /100 ”.
Press the key Enter ( Shown in Figure 3-23).

(2) Select H2 and press the lower right corner of it, drag it to H21 (Shown in Figure 3-24).

(3) Input “Tax Rate” on I1. Select 12. Select “Insert Function” on the “Formulas” tab.
Then there will be a dialog box. Select “IF” from the list. Click “OK” (Shown in Figure 3-25).

(4) Input each item in “Logical_test” , “Value_if_true” and “Value_if_false” on the dialog
box “Function Arguments”. After that, click “OK” (Shown in Figure 3-26).



IH9-t- = Practice on Excel Datasdse - Microsoft Excel - [m] "
i Home '_ Insert  Pagelsyout Formulss Data  Review View Adddns Tesm & @ o @ B

' Calibri i - 'E}- = Geneal - A a=inset~ E - ? ﬁ
g fa- BIU- Ay EFSEEH §-% » e oetete - @~ b )
T B-A (EE Y (B - | BEiromat- | @ Fiter+ select-
Clipboard 1 | Font 5|  Alignment | Number | cens Editing
G2 ~E | Beijing g
4 a | 8 | © | o | E | Tt e T O 5
1 |Index Name  Salary Diploma 1D card Score Location i
2] 151 8000 Master  200921198712260546  95.3|Beijin
E3 25tu2 6000 Bachelor  110501197905031267 8.
la] 353 5000 College Easem)smzum 924
|'s| astua 3500 Senior High 551164196811292168 75
|6 555 6000 Bachelor  '123642199012193315 85,
EA 656 5000 College :saamm?msmma 84,
|8 7stu7 8000 Master 516195197606110549 65
|9 858 6000 Bachel "123784196 7 63
|10 9stug 5000 College  '154978196810289234  78.1
|11 10 Stu 10 3500 Senior High '456789195905084945 85
|12/ 11 Stu1l 8000 Master  456713198007145522 92, | L
|13 12 5tu12 6000 Bachelor  154795197905031679 7
|14 13 Stu13 5000 College  '157164196703175756 514
|15 14 Stu 14 3500 Senior High '159456196008060917  33.2
|16 15 Tom 6000 Master  '132204198310018822 85,5
|17 16 5tu 15 6000 Bachelor  132204198810018822 88
|18 17 5tu17 8000 Master  123456196702164567  80.5
|19 18 Stu 18 6000 Bachelor  187241198211304655 91
|20 19 Stu19 5000 College  '356715197607153497 £
|21 20 Stu 20 3500 Senior High '187167198007168713 60
|22
|22
|2 L
E_ -
M4

Figure 3-21 Input “Beijing” from G2 to G12

IH9-t- = Practice on Excel Datasdsx - Microsoft Excel - [m] -4
i Home '_ Insert  Pagelayout Formulss Data  Review View Adddns Tesm & @ o @ B

E:. Calibri sn - ®[Elm & cnem - A Gt ;-?ﬁ

BJIU- Ay ESEEH §-% » 3 Delete -
paste o 2 Styles |, Sort & Find &
- & B S A FeE p | WS - | EiFomat- | @+ Fiter~ select
Clipboard 1 | Font = Alignment fa| Mumber & | Cells Editing
G13 - f« | shanghai *

| V([ -] [y e E T e T O
| 1 |Index Name  Salary Diploma 1D card Score  Location W
| 2 Beijing Beijing Beijing Beijing Beijing Beijing Beijing
3] 25tu2 6000 Bachelor  110501197905031267  88.2 Beijing
la] 353 5000 College Easm)smmm 92.4 Beijing
|'s| astus 3500 Senior High 551164196811292168 75 Beljing
|6 555 6000 Bachelor  '123642199012193315 85 Beijing
EA 656 5000 College :saammmsmma 84.6 Beijing
| 8 757 8000 Master 516195197606110549 65.6 Beijing
EX 858 6000 Bachel "123784196 7 63 Beijing
|10 95tug 5000 College  154978196810289234  78.1 Beijing
|11 10 Stu 10 3500 Senior High 456789195905084945 86 Beijing
|12 11 5tuil 8000 Master  456713198007145522  92.5 Beijing -
|13 12 stu12 6000 Bachelor  '154735197905031679
| 10 13 Stu13 5000 College  157164196703175756
|15 14 Stu 14 3500 Senior High 159456196008060917
|16 15 Tom 6000 Master '132204198810018822
|17 16 5tu 15 6000 Bachelor  132204198810018822
| 18 17 5tu17 8000 Master  123456196702164567
| 19 18 Stu 18 6000 Bachelor  187241198211304655
|20 19 Stu 19 5000 College  '356715197607153457
|21 20 Stu 20 3500 Senior High '187167198007168713
|22
|23
|24
|25

Figure 3-22  Input “Shanghai” from G13 to G21
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d9-t-= Practice on Excel Datasdse - Microsoft Excel - [m] -4
i Home '_ Insert  Pagelayout Formulss Data  Review View Adddns Tesm & @ o @ B

% 1 v o o S Geneml v A g=inert~ | E = 9‘( m
Ba- B r u AV EEETE 9 % I Delete - | -
Fste =i - A FE| 2 | W e Bl rormat - | @~ fsloll:re: sHeT::-
Clipboard & Fant .| Alignment | Number | cens Editing |
UINEST -t XY g
4 A | s | € | D E [k ] e R
1 |Index  Name ploma 1D card Seasassbacation Total Sala F
2] 15tul %r "200921198712260546 m jing [F2/100 |
I 252 for  11050119790503126 jing
| 4| 3stu3 5000 College  '456723197901211672  92.4 Beijing
5] aswa 3500 Senior High :ssneemmmnss 75 Beljing
|6 | 55wWs 6000 Bachelor  '123642199012193315 85 Beijing
7] 65wW6 5000 College :saamm?msmma 84.6 Belfing
el 7stu7 8000 Master  '516195197606110543 65.6 Baijing
EX 858 6000 Bachel "123784196 7 53 Beijing
|10 95tu9 5000 College  154978196810289234  78.1 Beijing
|11 10 Stu 10 3500 Senior High '456789195905084945 86 Beijing
|12 11 Stu11 8000 Master  456713198007145522  92.5 Beijing o
|13 12 Stu12 6000 Bachelor  '154795197905031679 75 Shanghai
| 14 13 Stu13 5000 College  '157164196703175756  51.4 Shanghai
| 15 14 Stu14 3500 Senior High 159456196008060917  33.2 Shanghai
|16 15 Tom 6000 Master  |132204198810018822 85.5 Shanghal
| 17| 16 Stu15 6000 Bachelor  '132204198810018822 88 Shanghal
| 18| 17 5tu17 8000 Master 1 80.5 Shang]
|19 18 Stu18 6000 Bachelor  '187341198211304655 31 Shanghai
|20 19 stu19 5000 College  356715197607153497 38 shanghai
|21 20 Stu20 3500 Senior High '187167198007168713 60 Shanghai
|22
|23
= L]
2
M4+ ¥ Datal ‘Data2  Datad . Data ™ |

Figure 3-23  Input a formula

H9-t-= Practice on Excel Datasdsx - Microsoft Excel - [m] -4
i Home '_ Insert  Pagelayout Formulss Data  Review View Adddns Tesm & @ o @ B

% calibri -l - 'E}- EF |General - A geinset~ E - ? ﬁ
S - BIZU- ANy ESEEH B|-% o | T Deiete - i—m&mm
S F T &-A I“F# LA -+ | [EFfomat- | @~ Finer~ Select~
Clipboard & Font n|  Alignment | Number | cens Editing |
H2 - £ | =c2*F2/100 Q

4 A | 8 | © | D | E [F ] Vg [ =
1 |Index Name  Salary Diploma 1D card Score Location Total Salary I

2] 15tul 8000 Master  '200921198712260546  95.3 Beijing 7624

3] 252 6000 Bachelor  '110501197905031267 ~ 88.2 Beijing

la] 353 5000 College  '456723197901211672  92.4 Beijing

|s| 4stua 3500 Senior High :ssnmssmmnss 75 Beljing

|6 55tus 6000 Bachelor  123642199012193315 85 Beijing

7] 65tu6 5000 College :saammmma 24.6 Beijing

| 8 757 8000 Master 516195197606110549 65.6 Beijing

EX 858 6000 Bachel "123784196 7 63 Beijing

|10 959 5000 College  154978196810289234  78.1 Beijing

|11 10 Stu 10 3500 Senior High '456789195905084945 86 Beijing

|12, 11 Stull 8000 Master  456713198007145522  92.5 Beijing =

|13 12 Stu12 6000 Bachelor  '154795197905031679 75 shanghai

|14 13 Stu13 5000 College  '157164196703175756 514 Shanghai

|15 14 Stu14 3500 Senior High 159456196008060917  33.2 Shanghai

|16 15 Tom 6000 Master  '132204198810018822  85.5 Shanghal

|17 16 Stu 15 6000 Bachelor  '132204198810018822 88 Shanghal

| 18| 17 5tu17 8000 Master 1 80.5 Shang]

|19 18 Stu1s 6000 Bachelor  '187341198211304655 91 Shanghai

| 20| 19 stu1s 5000 College  '356715197607153497 38 Shanghai

|21 20 5tu 20 3500 Senior High '187167198007168713 60 Shangh

|22/

|12

|2 L
25

M4

Figure 3-24  Fill the column “Total Salary”
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¥l Practice on Excel Dataxdsx - Microsoft Excel - b4

ata  Review View Addins Team o @ = @ B

Home  Inset  Page Layoutlll Formulas
AutoSum = [ Logical - 55 Define Name - @ 2
- Ti - - o .
= Recentty Used = [ Text i o S Use in Formula P ) e
Function i Financial -~ EBI‘! & Time ~ n‘ Manager B Create from Selection  Auditing - o
Function Library Defined Names | |
12 - xR - Q
4 8 | e | o | E | T ) T e o S
1 MName  Salary Diploma ID card Score Location Total kﬁ'
= r
2 |5tul =
Estu E: Insert Function ? X 5
| 4 Stu3 Search for a function: 4620
| 5 Sswa | Type a brief desaripbon of what you want to do and then dick | Go 2625
6 fsus | [0 R 5100
| 7 stus uﬂuagw[umﬂrw E 4230
| 8 Stu7 Selecta 5248
| 9 stus 3780
10 Stus 3305
= S
| 11 stu10 AVERAGE 3010
HYPERLINK
|12 stun1 7400 =
13 Stu12 MAX, b 4500
|14 Stu13 | IF(logical_testvalue_if_truevalue_if 2570
h chit walue if TRUE, and another
|15|stu1s | Cheds 1162
| 16 Tom 5130
|17 stu1s 5280
| 18 stu17 6440
19 |Stul8 | Heb on thes function 5460
|20 (Stu1s L 1300
| 21 stu 20 2100
E
B
e i
25
= — . . -
M4+ ¥ Datal -Data?  Data3  Datad €3 O 1 u

Figure 3-25  Another way to input a formula

Id9-0-|= Practice on Excel Datasdse - Microsoft Excel - o
Home  Insert  Page Layout | Formulas .| Data Review View Addins Tesm & @ o @ B

‘ft E AutoSum = ﬂ» Logical - - g 55 Define Name - ® 3
B Recently Used - & Text - k- JB Use in Formula -
Insert Hame Formuls | Calculation
Function [ Finandial B Date & Time - - Manager il Create from Selection | Auditing - |
Function Library Defined Names | |
IF - (© K & f =IF(H2>7000,0.3,0) Q
4 8 | ¢ | o | E | I ] R e IS
1 MName  Salary Diploma ID card Score Location Total Salary TaxRate [ ]
2 [stu1 8000 Master  200921138712260546  95.3 Beijing 624[0,0.3,0
3 (5tu2 6000 Bachelor "110501197905031267 88.2 Beijing 5292
! t | . |
? b

= 0.3
Checks whether a condition is met, and returns one value if TRUE, and another value if FALSE. E
Value_if_false is the value that is retumed if Logical_test is FALSE. If omitted, FALSE |
is retumned. B

Formula result = 0.3
Help on this function.

Stu13 6000 Bachelor  187341198211304655 5460
20 stu19 5000 College  '356715197607153497 38 Shanghai 1900
21 stu20 3500 Senior High '187167198007168713 60 Shanghai 2100
M4+ ¥ Datal ‘Data2  Datad , Datad  ¥J e | M

Figure 3-26

Input a formula in “Function Arguments”

Chapter 3 Microsoft Excel 2010
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(5) Select 12 and press the lower right corner of it. Drag it to 121 to finish the calculation
(Shown in Figure 3-27).

|z|| H9-¢-|= Practice on Excel Dataxlsx - Microsoft Excel - a X
Home Insert  Page Layout | Formulas | Data Review View Add-Ins Team & e o g 2
ﬁ E AutoSum - @ Logical - &’ § A: Define Name ~ % 3
@ Recently Used ~ [3 Text = “ hd S Use in Formula d
Insert Name Formula | Calculation
Function ﬁ Financial ~ ﬁ Date & Time ~ ﬁ' Manager BS Create from Selection | Auditing = v
Function Library Defined Names
12 - (= £ | =1F(H2>7000,0.3,0) ¥
4 B c | b E I G | H 1 =
| 1 |Name Salary Diploma ID card Score Location Total Salary Tax Rate
| 2 |Stul 8000 Master "200921198712260546 95.3 Beijing 7624 0.3}
3 |Stu2 6000 Bachelor  110501197905031267 88.2 Beijing 5292
4 |Stu3 5000 College "456723197901211672 92.4 Beijing 4620
5 |Stua 3500 Senior High ’551164196811292168 75 Beijing 2625
_6_ Stus 6000 Bachelor r12364?_139012193315 85 Beijing 5100
7 [stub 5000 College ’543784197605081524 4.6 Beijing 4230
| 8 |Stu7 8000 Master 316195]3?505110549 65.6 Beijing 5243
| 9 |Stug 6000 Bachelor '123734196?0630456? 63 Beijing 3780
10 Stu9 5000 College  '154978196810289234  78.1 Beijing 3905
11 |Stu 10 3500 Senior High "456789195905084945 86 Beijing 3010
12 |Stull 8000 Master "456713198007145522 92.5 Beijing 7400 =
13 Stu 12 6000 Bachelor  '154795197905031679 75 Shanghai 4500
14 |Stu13 5000 College "157164196703175756 51.4 shanghai 2570
15 Stuia 3500 Senior High "159456196008060917 33.2 Shanghai 1162
16 Tom 6000 Master  '132204198810018822  85.5 Shanghai 5130
| 17 |S5tu 15 6000 Bachelor ’132204]3831()1)18822 88 Shanghai 5280
18 [Stu17 8000 Master "123456196702164567 80.5 Shanghai 6440
19 |5tull 6000 Bachelor '13?34U38211304655 91 Shanghai 5460
| 20 |Stu 19 5000 College "356715197607153497 38 Shanghai 1300
21 Stu 20 3500 Senior High "187167198007168713 60 Shanghai 2100
2
23
25 -
4 < ¥ ¥ patal /Data? Datad , Datad %3 nE! il 0!
Drag inside selection to delete cells | | jom o -

Figure 3-27 Calculate Tax Rate for all students

(6) To calculate the age of each students, add a new column named Age before the column
D. Select C2 and input “=INT( YEAR(TODAY () )-MID(F2,7,4))” on the “Formula Bar”
(Shown in Figure 3-28).

(7) Select C2 and press the lower right corner of it. Drag it to C21 (Shown in Figure 3-29).

3.2.3.3 Table Design

(1) Insert a new row before the first row and input the title “Information and Salary of the
Dahua Company” (Shown in Figure 3-30).

(2) Set the title’ s font to “Calibri”, size 14, bold, light green, center, and the second
row’ s font to bold. Fill the second row with “Orange Accent 6” by using “Fill Color” on the
“Home” tab (Shown in Figure 3-31).

(3) Select Al1:J22. Double click Center button on the “Home” tab to center all texts. Add
all borders for it by using “More Borders” on the “Home” tab ( Shown in Figure 3-32).



4 Q- |w Practice on Excel Dataxdsc - Microsoft Excel - a *
Home Insert Page Layout Formulas | Data Review View Addins Team & o =@ B

j.‘ E Autosum - @ logical= - 1 SaDefine Name - ® &
B Recently Used - (A Text - B = PuscinFomu-
Insert Hame Formula | Calcutation
Function [ Financial = B Date &Time = {1~ | panager B Create from Selection | Auditing = -
Function Library Defined Names

IF -=x

4 A | 8 [TT€ H
| 1 |index Name p 1D card Score  Location Total |
2] 1sw1 ¥())-MiD(F2,7,4))| 712260546 | 95.3 Beijing
|3] 25tu2 6000 Bachelor  110501197905031267  88.2 Beijing
| 4| 35tu3 5000 College  '456723197301211672  92.4 Beljing
s | astua 3500 Senior High '551164196811292168 75 Beijing
| 6 | 5 5tus 6000 Bachelor  '123642199012193315 85 Beljing
7] 656 5000 College  '543784197605081524  84.6 Beijing
|8 | 757 8000 Master  '516195197606110549  65.6 Beljing
|9 85tus 6000 Bachelor 123784196 67 63 Beijing
| 10| 95tu9 5000 College  154978196810289234  78.1 Beijing
|11 10 Stu 10 3500 Senior High 456789135305084945 86 Beijing
| 12| 11 Stu1l 8000 Master 456713198007145522  92.5 Beljing .
|13 12 Stu 12 6000 Bachelor  154795137905031679 75 shanghai
| 14| 13 Stu13 5000 College  '157164196703175756  51.4 Shanghai
£ 14 Stu 14 3500 Senior High :mmmu 33.2 Shangllal
| 16 | 15 Tom 6000 Master 132204198810018822 85.5 Shanghal
| 17| 16 5tu 15 6000 Bachelor 13 2 88 shangh
18| 17 Stw17 8000 Master  '123456196702164567  80.5 Shanghal
| 19| 18 Stu 18 6000 Bachelor  '187341198211304655 91 Shanghai
| 20| 19 St 19 5000 College  356715197607153497 38 Shanghal
|21 20 S5tu 20 3500 Senior High "187167198007168713 60 Shanghai
| 22|
| 23|
2] L
b4
|[M 4> vl Datal Data2 ‘Data3 , Datad ‘ M 1

Figure 3-28 Calculate age for each students

- Practice on Excel Dataxdsx - Microsoft Excel - o x
Home  Insert  Page Layout [‘Formuiss | Data Review view adddns  Team c@=oF B

j.‘ E Autosum - [ Logical - - 52 Define Name = ® a3

B Recently Used - (& Text - B’ P £ Use in Formuta - aeml Dt

;:',.’m,,. B Finandial - B Date & Time - - ,,‘.,.."';., P Create from Selection | Auditing = -
Function Library Defined Names
c2 - = S« | =INT(YEAR(TODAY())-MID(F2,7,4)) g
7 R T O O e T S 2 | F T L 5

| 1 |Index Name Salary Diploma 1D card Score Location Total |
2] 1Stul 31 8000 Master "200921198712260546  95.3 Beijing
3 25tu2 6000 Bachelor  '110501197905031267 8.2 Beijing
KX 3 Stul 5000 College  456723197301211672  92.4 Beljing
|s | 4 5tua 3500 Senior High '551164196811252168 75 Beijing
| 6| 5Stus 6000 Bachelor  123642199012193315 85 Beijing
| 7| 65tub 5000 College  '5437B4197605081524  84.6 Beijing
|8 | 75tu7 8000 Master '516195197606110549  65.6 Beljing
|9 | 85tug 6000 Bachelor 123784196 67 63 Beijing
|10 9 Stug 5000 College  '151978196810289234  75.1 Beljing
|11 10 Stu 10 3500 Senior High 456789135905084945 86 Beijing
|12 11 Stu 1l 8000 Master '456713198007145522  92.5 Beljing =
|13 12 stu12 6000 Bachelor  '154735197905031679 75 Shanghai
|14 | 13 Stu 13 5000 College  157164196703175756 514 Shanghai
|15 | 14 5tu 14 3500 Senior High 153456196008060917  33.2 Shanghai
16 15 Tom 6000 Master "132204198510018822 5.5 Shanghal
| 17| 16 5tu 15 6000 Bachelor 13 2 88 shangh
|18 17 Stu 17 8000 Master "123456196702164567  80.5 Shanghal
|19 18 Stu 18 6000 Bachelor  '187341198211304655 91 Shanghai
| 20 19 Stu 19 5000 College  '356715197607153497 38 Shanghal
|21 20 5tu 20 3500 Senior High '187167198007168713 60 Shanghai
12
=3
|24 F
=1
H 4

Figure 3-29  Finish calculating ages
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N--|v Practice on Excel Dataxisx - Microsoft Excel = o x
| Home ]‘_ insert  Pagelayout Formulss  Data  Review View Addins Team o @ = @ B

B % cambri s - Sl B enem - A dmmets E- %r ﬁ
@ BIU- A EEREN Y% || o | @ 2 T
- F B S-A- |il§! 2 W3 = | [EFormat~ | 2+ Fiter~ Select-
Clipboard 1= Font fa|  Alignment fa| Number & Celis Editing |
Al - = S« | Information and Salary of the Dahua Company Q
e = = = =TT e
[nformation and Salary of the Dahua Company ]~
Index Kame  Ag Salary Diploma 1D card Score Location Total Salary Tax Rate
15w1 1 8000 Master  '200971138712260546 953 Beijing T624 03
25m2 3 5000 Bachelor  '110501157905031267 882 Beijing 5252 0
3 5w3 » S000 College  '856723157901211672 924 Beijing 4620 [
45wa 50 3500 Senior High B51164196811202168 75 Beijing 2825 []
5 5w5 = 6000 Bachelor  '123642190012193315 85 Beijing 5100 [
65wWE a2 5000 College  '543784197605081524 846 Beijing 4230 0
9 757 [ 8000 Master  '516195157606110549 656 Beijing 5248 0
|20 B 5wE 51 6000 Bachelor  '1237841967D6304567 63 Beijing 780 [
Et 9 59 0 5000 College  'IS4TEIS6810289234 781 Beijing 3905 0
12 10 St 10 59 3500 Senior High 356785195005084945 86 Beljing 3010 [
13 1 s 38 8000 Master  '56713198007145522 925 Beijing 7400 03
1 12 Sw12 £ 6000 Bachelor 1 5 4500 0 g
15 135w13 51 5000 College 1 75756 514 570 ]
|15 14 5t 14 58 3500 Senior High |1 7| m2 1182 0
|27 15 Tom "] 5000 Master  '132204138810018827 855 Shanghai 5130 [
|18 16 St 15 0 6000 Bachelor  '132204158810018822 88 Shanghai 5280 [
|19 17 5w 17 51 8000 Master 1 805 6440 ]
|20 18 Sw 18 £ 6000 Bachelor  '187341198211304655 91 shanghai 5450 0
n 19 5w 19 a2 S000 College  '356715197607153457 38 Shanghai 1900 []
|22 20 5w 20 8 3500 Senior High ISTI671S8007168713 60 Shanghai 2100 [
5
|2
|25
26|
[27]
|28 L
29
[nl

Figure 3-30 Input the title

N-- |5 Practice on Excel Dataxisx - Microsoft Excel = o x
| Home ]lﬂ"" Pagelayout Formulas Data Review View Adddns Team o @ o= @ B

™ b canbii - S F cenem - A Svmsets E- ;r ﬁ
. h-m A EEEE Fo% o Poaee | @ :
Paste styles | Sort & Find &
- é' |'5l¢ 2 | WA - [Elromat- | 2+ Fiter Select-
Clipboard 1= fa|  Alignment fa| MNumber & Celis Editing |
A2 - & £ | Index Q
] i C D = F G| A 1 o k=
i o
2 z
(3] 15w1 31 8000 Master 1138712260546 95.3 Beijing T624 03
4| 25m2 3 5000 Bachelor  '110501157905031267 882 Beijing 5292 0
Is| 3 5w3 E) 5000 College  '856723157901211672 924 Beijing 4620 [
IRl 45wa 50 3500 Senior High B51164196811292168 75 Beijing 2625 []
7 5 5w5 ] 6000 Bachelor  '123642190012193315 85 Beijing 5100 (]
s 65WE 2 5000 College  |543784197605081524 846 Beijing 4230 0
] Tsw7 a2 8000 Master  '516195157606110543 655 Beiling 5248 [
|20 B 5wE 51 6000 Bachelor  '1237841967D6304567 63 Beiling 780 0
|12 9 59 0 5000 College  'IS4TEIS6E10289234 781 Beijing 3905 [
|12 10 St 10 59 3500 Senior High 56785195005084945 86 Beiling 3010 (]
13 1 sl 38 8000 Master  '95671319B007145522 925 Beijing 7400 03
|1a 12 5w 12 39 6000 Bachelor 1 i 4500 0|g
|15 13 5w 13 51 5000 College 1 75756 514 =70 [
15 14 5w 14 L] 3500 Senior High 1 7 B2 1162 0
|27 15 Tom "] 5000 Master  '132204138810018827 855 Shanghai 5130 [
ET 16 St 15 0 6000 Bachelor  '132204158810018822 88 Shanghai 5280 [
19 17 Sw 17 51 8000 Master 1 805 6440 [l
|20 18 Stu 18 £ 6000 Bachelor  '187341198211304655 91 shanghai 5460 0
| 19 5w 19 a2 S000 College  '356715197607153457 38 Shanghai 1900 [
|22 20 5w 20 8 3500 Senior High ISTI6T1SB007168713 60 Shanghai 2100 [
B
|2
|25
|26
|27
|28 E
|22

Figure 3-31 Design for title and the second row
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Home ] Insert  Pagelayout Formulas Data Review View Add-ns Team & 0 o &8
j"j 4 cabni w14 | Wl & [Genent - | A Geimsetc E- %r @
s|'B.I U AL 3= ﬁ'% L] 3% Delete ~ i'

Paste Styles Sort & Find &
. & - A~ o <8 %8 - | [EiFormat~ | @~ Fiter~ Select~
Clipboard & nt F] ! | MNumber @& Cells Editing
Al - (= Fa Double-click [31ary of the Dahua Company ¥

Figure 3-32  Finish the basic design of the table

3.2.3.4 Charts

(1) To insert a chart of 2D Clustered Column, Select B2:C22. Find “Charts” on the Insert
tab. Click it. It will show a list of all kinds of charts. Select “Column” and the first chart type
under “2-D Column” (Shown in Figure 3-33).

(2) The resulting chart will be shown in Figure 3-34. You can try some other charts and
other settings if you like.

3.2.4 Self test practice

1. Practice 1
Open “Excel Data. xlsx” and copy the table in worksheet 2 and paste it onto a new Excel.
Save it as “Excel Data-practice 1. xlsx”.
® Insert a chart of 2D Clustered Column by using the table in worksheet 2 according to
Figure 3-35.
® Set the gridlines to “Dash Dot”.

Chapter 3 Microsoft Excel 2010
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Practice on Excel Dataxlsx - Microsoft Excel

@ 9=

Home Insert| Page Layout  Formulas Data  Review View  Add-ins

[m] x

Team Qenﬁﬁ

CEERIsl- S @ @B

=

PivotTable Table Picture Clip harts Bparklines Slicer | Hyperlink = Text Header _ Symbols
¥ Art [T o Box~ & Footer "8 ¥
Tables Iltustrations L | Filter Links Text

m__ e @S dyl: D -
il el e = 2 olumn| fline ie  Bar  Area Scatter Other : . -
1 - - - - - ~  Charts~ R (]
2 | Index . & Salary | Tax Rate
3 1 — — 5.3 | Beijing | 7624 03
4 2 |Iu M 32 | Beijing | 5292 0
5 3 24 | Beijing | 4620 0
6 4 3 15 | Beijing | 2625 0
2| s 5000 | +0 Column |5 | Beijing | 5100 0
8 6 5000 | 16 | Beijing 4230 []
= = ol 8] 199 99 e e
0] s 6000 i3 | Beijing [ 3780 0
1 9 5000 | Cylinder 3.1 | Beijing 3905 o
2] 10 3500 I 16 | Beijing | 3010 0
= = o o] [08] [ i
18| 12 6000 l s |shanghai| 4500 0 =l
|35] 13 S000| cone L4 |[shanghai| 2570 0
|16 14 3500 | — — — _ 82 [shanghai| 1162 0
17| 15 6000 il . 55 |shanghai| 5130 0
18] 16 6000 lm ‘ 18 |shanghail 5280 0
18] 17 8000 15 [shanghai| 6440 []
(20| 18 6000 | Pyramid i |shanghai| 5460 )
21| 19 5000 i8 [shanghail 1300 0
E == k] [a] 00 (=
| 23|
|24 il A0 chart Types..,
w?é" -
|26 |
|27
28 | &

4+ M Datal /Data2 Data3

Figure 3-33 Insert a chart of 2D Clustered Column
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®Age

Figure 3-34  The resulting chart

Set the “Maximum” of y-axis to 800 with the “Major Unit” of 200.

Set the y-axis to “No Border”.

Set the Chart Title to “Printers are more popular than projectors”.

Set the Shape Color to Green and Dark Blue respectively.



® Set the table size to 12 * 10 ( Height 12, Width 10).

2. Practice 2

r i
Printers are more popular '
than projectors

B Projector |
B Printer

Jan Feb Mar Apr May Jun

Figure 3-35 The resulting chart for practice 1

Open “Excel Data. xlsx” and copy the table in worksheet 3 and paste it onto a new Excel.

Save it as “Excel Data-practice 2. xlsx”.

® Insert a chart of 2D Clustered Column by using the table in worksheet 3 according to

Figure 3-36.

® Put “Rate of Paid Users” to the Secondary Axis, and change its type to “Line”.

20

14
12
10

18 +—
16 A

14
JREY

10

I New Users

o N & O 0

= Rate of Paid Users

Jan Feb Mar Apr May Jun Jul Aug

3. Practice 3

Figure 3-36  The resulting chart for practice 2

Open “Excel Data. xlsx” and copy the table in worksheet 4 and paste it onto a new Excel.

Save it as “Excel Data-practice 3. xlsx”.

® Add the table named “Sales Figure for Fenghua Market” , and set it to Calibra, size 18,

Chapter 3 Microsoft Excel 2010
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bold, italic according to Figure 3-37.

® Fill the Index column with 01001 to 01007.

® (alculate the Total Sale by multiplying “Price” and “Sale”.

® Merge and Center A10 : D10, and calculate “Total” on E10.

® Set the “Format Cells” of the two columns “Price” and “Sale” to “Number” with 2
Decimal places.

® Add solid blue Outside Borders to the table.

® On D12, Calculate the amount of goods which has more than 300 Sales( Hint: Use the
formula =COUNTIF(D3.D9), “>”&300).

1  Sales Figure for Fenghua Market
2 |Index Name Price Sale Total Sale]
3 01001 v 1215000  185.00{2247750.00
4 (01002  [Camera 6500.00]  103.00/669500.00
5 01003 Fridge 3880.00  268.00{1039840.00
6 '01004 Computer 4888.00 500.00(2444000.00
7 (01005 Speakes 8588.00 88.00[755744.00
= 01006 f{::::f 195000  311.00{606450.00
9 FNDO'.I' ’E_ . 3190.00|  458.00]1461020.00
Condi tioner
10 Total 224304.00
11
12| 3

Figure 3-37 The resulting chart for the Practice 3

3.3 Experiment 2;: Advanced Excel

3.3.1 Experiment purpose

The purpose of this experiment is to master other advanced operations of Excel, including
sorting, filter, and subtotal. There are more advanced tools that you should study by yourself on
the practice part. After finishing this manual, you will have the capability to handle many

practical problems by using Excel.

3.3.2 Experiment contents

This part of experiment should be finished in worksheet named “Data 2” of “Excel Data 2.
xlsx” . Copy the worksheet and paste to a new Excel. Save it as “Excel Data 2-practice 0. xlsx”.

® Filter all staff whose gender is Female (Shown in Figure 3-38).

® C(lear the filter.

® To find out which person gets the highest salary, or which gets the lowest, sort by the

column “Salary” from largest to smallest first, then sort by the column “Name” from A to



Z (Multi-level sort) (Shown in Figure 3-39).

® To calculate the average salary of different diploma, you can use the “Subtotal” tool

(Shown in Figure 3-40).
D Sort by the column “Diploma” from A to Z.

2 Add subtotal to “Salary” at each change in “Diploma” by using average function.

. ) [] C o |

_l-] Hams | Department Biplean Gender | Salary
2 Staff 1 wrkat (M tar Femals 6000
3 seaff 1) |rn Braster Female 3000
4 staff 17 _[Finanes sater Penale 5000
5 Staff 7 urkat [Mazter Fanals |B000
6 [staff 12 |r.m. Bachalor =N e000
7 Stuff 15 |hodun Bachalor ale 8000
B Staff 18 JMarket Bachaler . 000
9 Staffi 2 [sule Bachalor fressls  Jeooo
L4l A B c D E 10 Staff & |m Bachalor ale 6000
1 Neme v | Departmes -T Diplosa | Gende-T| Salar ~ 11 Seaff 8 [Sales Buchelor Fesale 6000
Fenale | 000 12 Staff 13 Market [Callugs ale 5000
3 ISeaff 11 Fenade 5000 13 seafi 18 | Jcellege hude  foon
4 Staff 17 |Finence ftaster Famale (6000 2 _|_5““ 1 jsdes Colluge ble 5000
5 Staff 7 [Market iaster Female o000 i teft 3 prodeer jeilie ale o000
-~ 16 Staff 6  |Finnce Collage [resals  [5000
9 Staff 2 |Sales Bachelor Fanale 6000 P iseatr o |Produr XTI e S
11 Staff 8 J5ales Bushaler Panily  JS000 18 Staff 10 |.-ndm [Senior Migh Fenals |00
16 Staff 6 [Pinunce Collage Fanale 5000 19 Staff 14_|Sudes [Samior High 3500
18 Steff 10 |Product [Senior Migh Female 3500 20 Staff 20 |Produst LS amior Migh )
Iii_ét_.ﬂ' 4 |Product [Senior Migh Female  |3500 21 Seaff 4 fsenior Migh  Jresade  [woo

College
| 10 College
n
112 s: College
|13 [Staf? 6 [Finunce Callege Female  |s000
128 sgr o [rrosue: Cellege Jaae 5000
= |
[ - 116 sz
v |27
+ |18 5:
+ |19 5
= |»
N T
| 22 st 14
T8
v |24
= |2 Semior High Aversge 3300
(=l 26 Grand Averszs 3600

Figure 3-40 The resulting table after subtotal

3.3.3 Experiment procedures

3.3.3.1 Filter

(1) Open the worksheet 2 named “Data 2” in “Excel Data 2. xlsx”.

paste it to a new Excel. Save it as “Excel Data 2-practice 0. xlsx”.
(2) Select Al, and then click the “Filter” button on the “Data” tab. The filter is now

available by simply clicking the list button on each item in row 1 ( Shown in Figure 3-41).

Copy the table and
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-0z Practice on Excel Data 2.xlsx - Microsoft Excel - o] 4
Home Insert Page Layout Formulas Data i Review View Add-Ins Team & o = @ B
B .@ @conmmnm 8l E 1 Cleat ﬁ a? [ Data valigation & Group ~ ;E
(& Properties Reapply . i Consolidate # Ungroup = =3
Get External  Refresh 7 ) il Sort Testto Remove . | e
Data - A= Edit Links Advanced | Columns Duplicates P What-if Analysis = | §f] subtotal
Connections Data Tools Outline )
D1 - (@& & | Gender v
4 a I B c F € | w | 1 ?
—ﬂ Nume ~ | Departae Diploma |~ b
_2__!5!-“ 1 arket Mastar
3 |Staff 11 |1 Master
4 Staff 17 |Finance [Mas tor
5 Staff 7 [arket Master
| 6 |Staff 12 [Finunce B?.E.'ﬂ'.‘.’,'_
7 |StafE 15 |Product Bachalor 5000 |
8 [staff 18 [urket Bachelor 5000 ®
9 Staff 2 |Sales EBachelor 6000
(10 staée 5 Bachelor 6000
11 (5tafE 8 |Sules Bachslor 5000
12 [Staff 13 [Market College 5000
13 Staff 16 |HR College 5000
14 |Staff 19 |Sales Collegs 5000
15 Staff 3 [Product Collage 5000 Vv
16 Staff 6 |Finance College Female |S000
17 Staff 9 |Preduct Collage [Malo 5000
18 [Staff 10 |Product Senior High Female  |3500
19 [staff 14 [Sules Semior High  [male 3500
20 Staff 20 |Product Senior High [iale 3500
21 seaff 4 [Product Samior High Female  |3500
2| -
| «» W[ Datal Pwot Table | Data 2 “Sheet3 @3 T4l [ |1
| Reay | B R e —

Figure 3-41 Click the button “Filter” to enable filtering

(3) Click the list button on D1, and you can see the list for both sorting and filtering. Click
the checkbox “Male” to cancel the selection. It means we want to filter all female staff but not all

male staff (Shown in Figure 3-42). Click “OK”.

-z Practice on Excel Data 2xlsx - Microsoft Excel - ] 0
Home Insert Page Layout Formulas Data Review View Add-Ins Team & o o @ B
= % <o - =|mlm & Genem - [F}conditionsi Formatting= S=insent- E - ﬂ Iﬁ
vl b m_' I U- Ay EEES- - % »  [romatasTable- P Detete - -
T D A EE » BN ) Cell Styles = B Format- | @+ pers Seneeto
Clipboard 1 Fant i Alignment M| MNumber Styles Cells Editing
D1 - (= £ | Gender v
| - F 6 | H | 1 %I
Diplema |~ &
%l saztoa s000
Sort by Color [BO00
g- Staff 7 % 5000 |
| 6 [stai 12 , [soo0 ™
7 |Staff 15 Text Eilters & 5000
8 - |00
B Search 2 6000
) (Select A 6000 L]
.u'sul‘f ] & 65000
12 |Steff 13 5000
13 oo
| 14 5000
1‘5 Staff 3 5000
16 Staff 6 5000
5000
e 3500
O Emeamet o0
3500
21 a4 [Produst |swmier High  [remde  |[os0o
-
W4 v Datal . PwotTable | Data2  Sheet3 &3 JOEd! = ] [
=2 [Ea@we 0 ®.

Figure 3-42  Click the list button on D1 and set the filter



(4) The resulting table is shown in Figure 3-43. You can notice the list button on DI is

different from others.

D -0-|= Practice on Excel Data Zabox - Microsoft Excel - ] *
Home Insert Page Layout Formulas Data Review View Add-Ins Team a@o@ s
= A F -ls (| & Genenl - [BdConditionalFormatting+  Swlnert+ K o é? &
- B o A EETE F-% o0 @Erometa e P odete - 3"
g D &-A- EE P W8 Base- EdFormat | 2+ Faaer Seiecs
Clipboard Fant 5. Alignment Humber Styles Cells Editing
o1 ~ (S fe | Gender Z
4 A B c D E E LG | & 1 =
1| Name | Departass = Diploms = | Gende.T| Salar - B |
2 [seaff 1 [harker Master Female  |e000
3 [staff 11 [raster Famale  |oo00
A |Staff 17 |Finance [Mastar Female E000
5 aster Femils o000 4
9 [seaif 2 [sudes Bachalor [l
1 seaif 8 Jsddes Bachsler Faails |00
16 (Seafi & [Finemes Callege Fesale  |5000
1B [Staff 10 |Froduct Senior High Female 3500
21 |seaif 4 |rru4-=et Senior High Famale |m
22]
3
.l
)
=t
7
.28
£=d|
e
31
5
e
2 ) -
W 4 » W] Datal  “Piot Table | Data 2 Sheetd 4 5 »
Lufiencr;.8 98 20 secords loond. | L B I

Figure 3-43  The resulting table after filtering all female staff

(5) You should cancel the filter before you want to do other works on Excel. To cancel it,

you can simply click the “Filter” button on the “Data” tab again. The button is not selected after

doing that. The table will go back to the original one (Shown in Figure 3-44).

D= Practice on Excel Data Zabox - Microsoft Excel - ] *
Home Insert Page Layout Formulay Data Review View Add-Ins Team a@o@ s
3 @ _;J Cnn.nztin.mi 8l m Clear E E'i. 5 Data validstion = & Group :7_
- rtie: Reapply [ Consatidate # Ungroup = =3
GetEsternal Retresh §| sort Tetto  Remove
Data = All- S8 Edit Links Advanced | Commns Duplicates (59 Whatdf Analysis = | HE] subtotal
Connections. Data Tooh Outline 0
(531 ~ (S fe | Gender Z
4 A B c D E En b Gallen 1 =
BBl wame v Bepactnan v Niplems. |v] Comdney] Sadas~ E|
2 [stafi 1 [harker [Master Female  |e000
3 [Staff 11 [raster Female 000
A (Staff 1T |Finance [ Female 000
5 [Steff 7 [Mazter Female 000 =
9 (Staff 2 |Sales Bachalor Femals 5000
11 [staff B[Sl Bachelor Fensle  Jeooo
16 (Seafi & [Finemes Callege Fesale  |5000
1B [Staff 10 [Froduct Senior High Female 3500
21 Stadf 4 |l’ruhe! Senior High Fanale |m
2]
£
el
5
x.
24|
2
E-J|
£
e
32|
E:]
| i

Figure 3-44  The way to cancel the filter
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3.3.3.2 Multi-level Sort

(1) Click the “Sort” button on the “Data” tab. The sort dialog will be open as shown in
Figure 3-45.

"L Practice on Excel Data 2xisx - Microsoft Excel - o X
inet  Pagelmyout  Formulas | Data | Review  View  Addins  Team & o_.:. =]
i |3} connections & Clear [ Data vandation ~ & Group = #3
R @ & Praperties o g T T Reapply | S Iﬂ [Fs Consalidate & Ungroup - =1
G«Eﬂml mmn | %) Filter Textto Remove
- S8 Edtlinks | W ndvanced | Coumns Duplicates 52 Whatat Anaiysis - | & subtotal
Ceﬂﬂmun; | Sort & Filter Data Tooks | Outline [
=) — - £ | 8000 Q
A B e[ e [ | ! by
_ Wame | Department | Diplema | Gemder | Salury M
u
Sort ? X |
[ Fiaddtond || X peetetevel || Sagopytevel |15 [ optors... | iy dta s esders !
Comn SortOn Order i
Bl Eli{ = (X 5]

Figure 3-45 Click the “Sort” button

(2) Select the value for each field: Sort by “Salary”, Sort on “Values”, and Order from
“Largest to Smallest” (Shown in Figure 3-46).

I Practice on Excel Data 2xlex - Microsoft Excel - o >

Insest  Pagelayout  Formulas | Data | Review  View  Adddns  Team a@o@

- \@ :;Zmrn, L:E ? & Clear E I'ﬂ gx:::un- :::;; ci

T Reapply

Get Etemal Refresh k| Sott | Fitter Testto Remove
Datas | py- = Edit Links W advanced | Coumns Duplicates 52 Whatat Anaiysis - | & subtotal
Connecions | Sart & Filter Data Tooks | Outline ]
——
] - £ | Boo0 Q
B a 3 5 e I e 1 5%

_ Mame | Bepartment | viplens | Gender | Salury

? X

Sort

| Aiaddtend || X peetetevel || Gagopytevel |51 15| optors.. [ My data has headers

Figure 3-46 Select the value for each field



(3) If you click

multi-level sort, Click the “ Add Level”

Figure 3-47).

“OK” right now, it can only implement a one-level sort. To implement the

button to add the second level for the sort ( Shown in

1~ B AN R
Hu-l Insest

&)

Get Edternal| Refresh
Data = A= = Edtlinks |

B

Practice on Excel Data 2xisx - Microsoft Excel — m] x

Pagelaout  Formulas | Data | Redew  View  Adddns  Tem c@o@Fn
-cnmmem m W e E !_5 2 oata valigation = % Group »  #3 "
[ Praperties T Reapply B Consolidate 4 Ungroup = =3

Soat Filter Test to
! B advanced | Coumns leutu 55 what It Analysis - | & subtotal

Connedtions | Sort & Filter Data Toals Outline &
|.
£l e [ u | ] %
u
T X
cetelevel || Uacopytevel [[ | [5 | optons.. | A Mydatahasheadess |
SartOn Orler 1
] [vakoes [&] [Lorgest to Smaest [~
[se]] [volues vl a2z i

Figure 3-47 Add a new level for the sort

(4) Select the value for each field (Shown in Figure 3-48). Click “OK”.

-t = Practice on Excel Data 2xdsx - Microsoft Excel - ] ®
_Home  insert  Fagelayout  Formuiss | Data ._ Review  View  Adddns  Team @ efl @
B @ @commns m & Clear E !_5 =8 Data valigation = % Group * 0}
[ Praperties G Reagply (B Consolidate 4 Ungroup =
Gctlxlﬂllll mmsn | sent Filter Textto Remove
- & Edtlinks | W advanced | Columns Duplicates 5P WhatIf Analysis = | & subtotal
| Connections | Sort & Filter Dats Tools Outline
E2 - & £ | 8000 Q
B e D w0 F | e | w | I =

| Departnent |

_viplons | Gender | Sulary

Sort

[ Pusdiend || X poeteteve || dagooriond || 4| (]| gptons.. |
Column
Sartby | calar

T x

[ My data has headers |

SartOn

Figure 3-48  Select the value for the second level of sort
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(5) The resulting table after multi-level sort is shown in Figure 3-49.

1= RN Rt Practice on Excel Data 2.xisx - Microsoft Excel - o x
Home  Injet  FPagelayout  Formulas | Data | Review  View  Adddns  Team a@oFEs
B |@ [B) connections ) 3% Y & Clear % !_! 8 Data Valigation = % Group = #3
W praperties T Reapply = B Consolidate # Ungroup = =3
&tnl.:;l‘t:'ul Refresh o Al | son Filter Textto Remove -
i inks g advanced | Columns Duphicates 5P WhatIf Analysis = | & subtotal
Connections | Sort & Filtes Data Tools Outline 0
E1 - £ | salary a
4 A B c D E F |l & | u | I =
i Hume artment Diplema Gender | Salary M
| 2 [Staff 1 [Market aster Female B000
3 Staff 11 |WR hr Feanle o000
| 4 seai 17 Jrinencs sster Feaile Igm
S5 |Staff 7 Il&l-nt aster Fenale BO00
| B istati 12 [Finencs Bachalor = Jeaca
7
!
12 (Seaff 13 [Market Collage Ml e E000
|13 |seatt 16 |m College ale 5000
14 Seaff 19 [Sales Collugs ule E000
15 (Staff 3 [Product College ale 5000 r
|16 seatt 6 [Finumen Collags Fensle |50m0
17 5taff 5 [Produce Collegs ale 000
T" Seaff 10 |Froduce | Sen or High Fenale 3500
|19 seaff 14 Jsades Senior High ale 500
20 Staff 20 |Froduse anior High . 3500
| 20 [seakf 4 Jeroduce snior High Feaale |00
2|
|M 4% W[ Datal ~Phot Table | Data2 ~Sheetd 83 - M4 u ]

Figure 3-49  The resulting table after multi-level sort

3.3.3.3 Subtotal

(1) Before adding a subtotal, sort by the “Diploma” from “A to Z” first ( Shown in
Figure 3-50).

-t Practice on Excel Data 2.xdsx - Microsoft Excel - o ®
Home  intet  Pagelayout  Formulas | Data | Review  View  Adddns  Tem a@ o @ s
B |@ [B] connections 3} @ & Clear % !_5 8 Data Valigation = & Group = #3
. I Properties T Reapply = B Consolidate 4 Ungroup = =3
Get External| Refresh Z| sot Fi 7, Testte  Remove
Dats= | an- 8 Edit links W advanced | Columns Duphicates 5P WhatIf Analysis = | & subtotal
Connections | Sort & Filtes Dats Toals Outline i
[=] - f | Bachelor a
B C I Fl e | un | I y

| o
| viplems | Gender

Sort

[Pt ieve || X poete Leve || Ea oy v |[2] [5][ optore. |
Cobsmn

9 My dats has headers

Sort On
&1 [

Order
[l [aw2

=

Figure 3-50 Sort by “Diploma” from “A to Z” first



(2) Click the “Subtotal” button on “Online” of the “Data” tab. Then the subtotal dialog
will be displayed as shown in Figure 3-51. To add the subtotal to “Salary” at each change in
Diploma, select the value for each field according to the Figure 3-51. Click “OK” after finishing.

IO~ |w Practice on Excel Data Zabo: - Microsoft Excel o o
Howe  Wsén  PageLout  FormUlis | Dela | Rerew  View  AOGhE  Team a@o@s

2 | R T | Y 1, [ B R [ 3
. il

Get External Refresh Sort Filter Testto Remave
Data All= =8 Edit Links

Connectians | Sort & Filter

.v (-

Figure 3-51  Open the Subtotal dialog and select the value for each field

(3) The resulting table will be shown in Figure 3-52.

IdM-0-| Practice on Excel Data 2xbox - Microsoft Excel - o *®
Mome  intet  Pagelayout  Formulss | Data | Review  View  Adddns  Team a@o@ s
B @ (3 connections 8l m Y & Clear !_5 5 Dsta validation = % Group = 93
\ & Properties £ To Reappty EE = B consondate # Ungroup - =3
Get External | Retresh %] sent | Filer Tetta  Remave
Data = Al &8 Edit Links W Advanced | commns (55 what-r anatysis - | B subtotal

Diata Tools Outline

&
x
el

Figure 3-52  The resulting table after adding subtotal to “Salary”
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3.3.4 Self test practice

1.

Practice 1

Open “Excel Data 2. xlsx” and copy the table in worksheet named “Data 17 and paste it to

a new Excel. Save it as “Excel Data 2-practice 1. xIsx”. Open a new document and save it as

“Screenshots-practice 1. xlsx” to save screenshots.

Add the column “Total” and “ Average” after “Physics”, and use the formula or function
to calculate the total score and the average score of each student.

To find out the ranking for total scores, do multi-level sort: first, sort by “Total” from
largest to smallest, then by “Student ID” from smallest to largest. Take a screenshot of
the resulting table and insert it to the document you have built.

Add a new column “Rank” after “ Average”, and input the rank of each student
according to the table.

To find out the ranking for physics scores, do multi-level sort again: first, sort by
“Physics” from largest to smallest, and then by “Name” from “Z to A”. Take a
screenshot of the resulting table and insert it to the document.

Filter all students whose gender is “Female”. Take a screenshot and insert it to the
document.

Clear the filter. Input “Average” in A15, “=SUBTOTAL(1, K2:K10)” in B15, and
“=SUBTOTAL ( 104, J2:J10)” in B16. Take a screenshot and insert it to the
document.

Clear the filter.

Filter all students whose gender is “Male” and ethnicity is “Han”. Take a screenshot
and insert it to the document.

Insert the filter condition in E19:G22 to filter all students who is failed in at least one
course ( shown in Figure 3-53). In the Figure 3-53, there’s a logical relation “and” in
the same row, while “or” in the same column. So the Figure means to filter all students
whose math is less than 60, or English is less than 60, or physics is less than 60. Take a
screenshot of the resulting table and insert it to the document (Hint: the filter condition
can be added by selecting the “ Advanced” button).

Change the filter condition to in E19;G21 to filter all students who are failed in both math
and English, or failed in physics (shown in Figure 3-54). The Figure 3-54 means to
filter all students whose math is less than 60 and English is less than 60, or physics is

less than 60. Take the screenshot and insert it to the document.

Math English Physics
<B0 Math English Physics
<60 <60 <60
<60 <60

Figure 3-53 Filter condition( 1) Figure 3-54 Filter condition(2)



® C(lear the filter.

® Use the same tool to filter all students whose math and English is greater than 80. Take
the screenshot and insert it to the document.

® C(lear the filter.

® Add subtotal to Al:KI10. Set “ At each change in” to “Class”, “Use function” to
“Average” , “Add subtotal to” math, English, physics and average. Take the screenshot
and insert it to the document.

® (lear the subtotal. Add another subtotal to the total score of each course according to
“Gender”. Take the screenshot and insert it to the document.

® C(lear the filter.

® After sorting by “Class” from “A to Z”, select all students in class 1601 and their three
courses’ scores. Create a Doughnut chart. Take the screenshot on the chart and insert it
to the document (Hint: study how to insert a Doughnut by yourself) .

® After sorting by “Class” from “A to Z”, select all students in class 1602 and their three
courses’ scores. Create a Cylinder chart. Take the screenshot on the chart and insert it
to the document.

2. Practice 2

Open “Excel Data. xlsx” and copy the table in worksheet 2 named “Data 2” and paste it to

a new Excel. Save it as “Excel Data 2-practice 2. xIsx”. Study how to insert a “Pivot Table” by
yourself.

® Insert a “Pivot Table” and count the total amount of male and female for each department
(Hint: Row Label: Department, Column Label: Gender, Value: Name). Take the
screenshot and insert it to the document.

® [nsert another “Pivot Table” and count the total amount of staff and the average salary for

each department. Take the screenshot and insert it to the document.

3.4 Experiment 3. Excel Project

3.4.1 Project topic

(1) You can select any topic you like to analyze data in Excel. There are some topics you
can choose from.

(D Student grade analysis.

Q) Sales report.

@ Personal consumption statistic.

(2) Suggestions: It will be better if you analyze data related to your major. You can also
choose data from your daily life, such as the statistics on the book information, on the

consumption in cafeteria, or on the scores for some or all courses.
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3.4.2 Experiment requirements

(1) Do data analysis to meet requirements in your chosen topic. For example, the analyses

on the students’ score are as follows:

Count the total score, and the total amount of courses a student chooses.
The average score of each course.

Sort the data by scores or by classes.

Insert a pie chart to compare the average score of several courses.

Any useful statistic methods you can think of...

(2) The attributes should be included in the table, that is, what does each column refer to?

For example, if you do analysis on the students’ score, the following columns should be

contained :

Student ID.
Student name.
Class.

Course 1D.
Course name.
Score.

Any attributes you can think of...

(3) The table should be in at least 20 rows and 4 columns.



